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Overview 

As a strategy towards reducing its carbon footprint, the United Nations has a target to become 
paperless wherever feasible.  Umoja supports this by facilitating the attachment of scanned 
documents into relevant transactions within the system, thus reducing the need for multiple 
copies and allowing access to the scanned documents by authorized parties from any UN 
location. 

 

Scanned documents attached to Umoja Transactions will be considered to be original 
documents from a trusted source, provided the following guidelines are followed: 

 If received via email, the original document is considered to be the combination of 
the email message as well as the attached document.  Both should be attached into 
the corresponding transaction in Umoja 

 If received via postal mail or hand delivery, the original document is considered to 
be the document itself 

 The scanned version of that document attached to the corresponding Umoja 
transaction will also be considered an original document from a trusted source 

 

This document aims to provide basic guidelines on how to upload (attach) documents in Umoja 
transactions.  The solution adopted by Umoja is “Records Management” which is an integration 
solution that allows the creation of record associated to specific SAP transactions.  These tips 
are related to file naming, extension and size.  The use of good naming convention, authorized 
file extensions, and reasonable file size will help enhance the Umoja user experience in terms of 
documents upload as well as performance.  It will also help maintain the system’s integrity, 
stability, and health.  The system automatically self protects itself by restricting certain file 
names and extensions.  Please see Attachments file naming convention and File name 
extensions section for more details.  The use of small file sizes should help improve 
performance in uploading and viewing documents, please see recommendations under the File 
size recommendation section for more details. 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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Support 

If any issue is encountered in Production, please contact your Local Process Expert and/or your 
Local Service Desk immediately.  They will escalate the incident and monitor it through its 
resolution. 

 

Please provide the following information: 

 SAP Transaction  identification and document number associated to transaction 

 Description of the issue you are facing; print screens are extremely useful to 
expedite resolution 

 

Should you require assistance during testing, please contact your designated Umoja Testing 
Functional Coordinator. 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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1. Umoja Business Scenarios with Active Attachment Functionality 

In order to address specific business requirements, Umoja has been configured to allow the 
attachment of documents in the following sub-set of business scenarios: 

 In SAP ECC 

o Financial documents with workflow 

o Financial documents without workflow 

o Funds Commitment / Pre-Commitment / Budgeting 

o Sales & Distribution: Contract / Quotation / Billing / Sales Orders 

o Logistic & Execution: Good Receipt / Service Entry Sheet / Deliveries / 
Purchase Orders 

o Architectural Objects in Real Estate 

o Grants Management Budget Approval and GM Master 

 In SAP SRM 

o Will allow for uploading of any relevant documents to Shopping Carts, 
Solicitations, Contracts and Purchase Orders 

 

The attachment of documents in Umoja has been configured to address different requirements, 
depending on the nature of each type of document.  For example: once a financial transaction 
is approved and posted, it should not be possible to change it further.  Such restriction also 
applies to the Original Documents attached to the transaction.  On the other hand, Real Estate 
documents (architectural objects, portfolios, etc.) may change on a regular basis, and so, the 
system configuration allows for new documents after a Real Estate entry has been saved in the 
system. 

In addition, SAP provides different approaches for scanning documents, depending on whether 
the user is working in ECC or in SRM. 

The following sections explain the particularities of attachments in Umoja, by type of 
transaction. 

 

1.1 Financial Documents with Workflow 

Before a financial document is posted in the system, the required Original Document should be 
attached to the corresponding SAP transaction.  It will be possible to attach documents during 
the whole cycle of each workflow-supported document, as long as such document has not been 
approved and posted in the system.  This means users will be able to continue uploading 
attachments to a particular transaction as far the document is in status “park” or “save as 
complete” the user  
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Note: The status of the attached Original Documents and the status of the corresponding 
transaction in SAP are not synchronized automatically, and thus users must be mindful of 
making attachments final by “closing” the scanned record.  Therefore, transaction approvers 
must change the status of the attached document to “Closed” at the time of posting the 
document. 

The final approver is responsible for validating the transaction supporting documentation 
before posting any financial entry in Umoja.  This also entails closing the corresponding 
document management record so that the attached original documents cannot be modified 
any longer.  

If the approver determines that the information provided are insufficient ( i.e., attachments are 
missing or are incomplete) the workflow approver should reject the financial document and 
request that the creator to attach/modify the documents.  Once the supporting Original 
Documents are validated and accepted by the final approver, the document management 
record attached to the transaction must closed in concurrence with the posting of the financial 
document. 

 

1.2 Financial Documents without Workflow 

Not all documents in the Finance modules are processed through workflow.  In some cases, the 
attachments will be uploaded in the Financial Accounting Document only after the document is 
saved.  The creator of the document will be responsible, as well,  for closing the scanned record 
or Original Document associated to the financial documents, so that they cannot be further 
modified.  

 

The following table lists the Finance documents that can receive attachments in Umoja, 
together with the corresponding transaction and the types of Original Documents that should 
be attached: 
 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Finance FV50 Park G/L Account 
Document  

FV53 / FB03 Calculation spreadsheet, 
memo & emails 

Finance FV60 Park Vendor Invoice FV63 / FB03 Vendor Invoice 

Finance FV65 Park Vendor Credit 
Memo 

FV63 / FB03 Vendor Credit Note 
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The following table lists the Financial Management documents that can receive attachments in 
Umoja, together with the corresponding transaction and the types of Original Documents that 
should be attached: 

 

 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Financial 
Management 

FMY3 Funds Pre-
Commitment 

FMY2 Memo, Agreements, 
MOUs 

Financial 
Management 

FMZ3 Funds Commitment FMZ2 Memo, Agreements, 
MOUs 

Financial 
Management 

FMBB Budgeting Work 
bench 

FMEDD Memo, Final Approval 
Instructions 

Financial 
Management 

FMX3 Funds Reservation FMX2 Memo, MOUs 

Financial 
Management 

FMW3 Funds Block  FMW2 Memo, Agreements, 
MOUs 

Financial 
Management 

FMY3 Funds Pre-
Commitment 

FMY2  

 

  

Finance FV70 Park Customer 
Invoice 

FV73 / FB03 Calculation spreadsheet, 
memo & emails 

Finance FV75 Park Customer 
Credit Memo 

FV73 / FB03 Calculation spreadsheet, 
memo & emails 

Finance MIR4 Display Invoice 
Document 

 Calculation spreadsheet, 
memo & emails 
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1.3 Logistics 

List of transactions available where documents can be attached: 

 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Logistic  Deliveries FMY2 Shipping Notification, 
Vendor Delivery 
Confirmation, Custom 
Documents, 
Correspondence (email & 
memos), Internal 
Supporting Documents 

Logistic MIGO Good Movements FMZ2 Receiving Documents, 
Vendor Returns, 
Correspondence (email & 
memos),  Internal 
Supporting Documents 

Logistic ML81N Service Entry Sheet  Supporting Documents 

 

1.4 Real Estate 

In Real Estate, the scanned records associated to each transaction will not be closed.  These 
types of documents are constantly uploaded and do not required approval. 

 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Real Estate REBDAO Process 
Architectural Object 

RE80 Portofolio Documents, 
Internal Documents 

Real Estate REBDBE Process Business 
Entity 

RE80 Portofolio Documents, 
Internal Documents 

Real Estate REBDPR Process Land RE80 Portofolio Documents, 
Internal Documents 

Real Estate REBDBU Process Building RE80 Portofolio Documents, 
Internal Documents 
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Real Estate REBDRO Process Rental 
Object 

RE80 Portofolio Documents, 
Internal Documents 

Real Estate RECN Process Contract  RE80 Contracts, Internal 
Documents   

 

1.5 Plant Maintenance 

In Plant Maintenance, the scanned records associated to each transaction will not be closed.  
These types of documents are constantly uploaded and do not required approval. 

 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Plant 
Maintenance 

IE02 / IE03 Equipment IE02/IE03 Equipment Assignment / 
Impairment Documents / 
Technical Documents / 
Transfer Documents / 
Write Off – Disposal 
Supporting Documents / 
Internal Supporting 
Documents 

Plant 
Maintenance 

IW32 / IW33 Work Order  Approval Documents/ 
Material & Operation 
Confirmation / Internal 
Supporting Documents 

Plant 
Maintenance 

IW53 / IW52 Service Notification  Sales & Services Order 
Documents / Write Off – 
Disposal Approvals / 
Internal Supporting 
Documents 
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1.6 Sales and Distribution 

In Sales & Distribution, the scanned records associated to each transaction can be closed as 
they are linked to an approval process. 

 

Application Attachment 
via  

Transaction 

SAP Descriptions Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Sales & 
Distribution 

VA42 Customer Contract  Purchasing Documents / 
Solicitations / Internal 
Order & Request / 
Disposal & Approval / 
Sales Contract / MOU / 
SLA / Claim & Other 
Supporting Documents 

Sales & 
Distribution 

VA22 / VA23 Customer Quotation  Purchasing Documents / 
Solicitations / Internal 
Order & Request / 
Disposal & Approval / 
Sales Contract / MOU / 
SLA / Claim & Other 
Supporting Documents 

Sales & 
Distribution 

VA02 / VA03 Sales Order  Purchasing Documents / 
Solicitations / Internal 
Order & Request / 
Disposal & Approval / 
Sales Contract / MOU / 
SLA / Claim & Other 
Supporting Documents 

Sales & 
Distribution 

VF02 / VF03 Customer Billing 
Document 

 Payment Documents / 
Funds Commitment Dcmt. 
/ Other Supporting 
Documents 
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1.7 Grants Management 

In Grants Management, the scanned records associated to Grants Management will not be 
closed.  These types of documents are constantly uploaded at different stages of the Grants 
Management Process to Grant Master Data Object (Grants) and do not required approval. 

Note that only final and signed or approved documents in PDF format should be uploaded in 
the system, i.e., no intermediary documents should be uploaded in the system.  

The following transactions can be used to upload documents to a Grant or Grants Budget 
document: 

 

Application Attachment 
via  

Transaction 

SAP 
Descriptions 

Alternative 
Transaction 

for Attaching 
Documents 

Original Documents to Be 
Attached 

Grants 
Management 

GMGRANT Maintain Grant  Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 

Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

Grants 
Management 

GMGRANTD Display Grant  Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 

Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

Grants 
Management 

GM_CREATE_B
UDGET 

Create Budget 
Document 

 Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 
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Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

Grants 
Management 

GM_BDGT_REL
EASE 

Release 
Budget 

 Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 

Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

Grants 
Management 

GM_DISPLAY_
BUDGET 

Display Budget 
Document  

 Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 

Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

Grants 
Management 

GM_MODIFY_
BUDGET 

Change Budget 
Document 

 Agreements with Donor 

Agreements with IP 

Budgetary related documents 
(if applicable) 

Substantive Reports to Donor 

Financial Reports to Donor 

Substantive Reports from IP 

Financial Reports from IP 

Other Communication 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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2. Record Models and Attachments 

In order to help users organize and retrieve attachments in Umoja, a “Record Model” has been 
configured for each transaction that requires attachments.   

The Record Model defines the folder structure as well as the document attributes (the type of 
document) required and helps to correctly classify each attachment, for easy identification and 
retrieval. 

When a user enters a transaction that has been configured to receive attachments, a record 
model is automatically created and linked to the transaction.   

The record model (folder structure) will change from one transaction to another.  

The example below illustrates a record model for a financial document, with its corresponding 
folder structure and record attributes: 

The user parks a vendor’s invoice and access the Record Management  

 

 

. 
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The corresponding record model is automatically created and linked to the transaction.   

 

 

 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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3. How to Access Records Management 

The Record Management is a utility available for attaching documents in Umoja.   

The Record Management can be access clicking the icon “Service for Object”  from most of 
transaction screens available in Umoja. However, in few transactions the “records management 
option” is part of the standard SAP menu. 

 

3.1 Finances, Logistic Execution, Service Delivery  and Plant Maintenance 

In the transactions associated with the Finance, Logistics, Service Delivery and Plan 
Maintenance modules,  the Records Management can be accessed clicking the Service for 
Object > Records Management menu item. 

A few examples: 

 For Goods Receipt 
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 For Sales Order 

 

 

3.2 Earmarked Funds 

For Funds Earmarked Documents, Records Management can be accessed through the menu by 
selecting the Environment > Object links > Records Management menu item. 
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3.3 Real Estate 

For Real Estate, Records Management can be accessed through the menu by selecting the 
Document Management icon. 

 
 

3.4 Grants Management 

For Grants Management Documents, Records Management can be accessed through the menu 
by selecting the Environment > Records Management menu item.  
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*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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4. How to Attach Documents in Umoja: Examples 

The following steps describe how to attach Account Payable (AP), Account Receivable (AR) and 
GL documents. 

 

Process Steps: 

1. Enter FB03 in the Command field to display the financial document generated by the 
system 

2. Click the Enter icon 

3. Enter the Document Number  

4. Click Enter icon 

 

 

 

5. Click the Services for Object icon 
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6. Click the Record Management icon.   

 

7. The Record Browser screen is displayed  
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8. Click the Change icon to edit the record and expand all sub nodes 

 

 

 

9. Double-click Vendor Invoice & Credit Memo.   

10. Alternatively right-click Vendor Invoice & Credit Memo and select the Activities > 
Create item 

 

 

 

11. To upload the document, attach the original document by clicking the Application > 
From File menu item 

12. Select From File menu item 
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13. Select the document from your system  

14. Click the Open button 
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15. To save the scanned document you need to assign attributes to the document by 
populating the key fields.  

 
16. Click Continue (Enter) icon 

 

Examples 

A. To save scanned financial documents populate the following attributes: 

i. Short description: Copy Unique ID to Short description attribute 

ii. Unique ID: Fiscal Year – Document Number – Sequential Doc Number 

iii. Business Partner 

iv. Business Area 

v. Fund 

vi. Document Type 

 

 

 

B. To save the scanned real estate document populate the following fields: 

i. Short description 

ii. Unique ID 

iii. Business Partner 

iv. Authorization Group 
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vii. Person Responsible 

 

Note: The Attributes can be used as parameters to search documents, therefore 
document with few attributes can be difficult to be retrieved 

 

17. Verify that document is attached  

18. Click the Save icon 

 

 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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5. How and When to Change Document’s Attributes 

Documents uploaded into SAP need to be updated with the proper attributes such as: Short 
description, Unique ID, Funds, Business Partner, etc. 

Some attributes can be changed after the document is uploaded while others that cannot be 
changed will remain gray out. 

NOTE:  If the attachments uploaded by mistake cannot be removed amend the Short 
Description adding the word “DO NOT USE” to the attribute 

 

Process Steps 

1. Select the record associated to transaction by clicking the Record Management icon 

 

2. The The Record Browser screen is displayed  

3. Right-click the document and select the Activities > Change atrribs item 
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4. Change any of the attributes by modifying the fields that require amendment 
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5. Click the Continue (Enter) icon to accept the changes 

 

 

 

6. Click the Save icon and select  Save in the dropdown menu 

7. Click the Exit icon or F3 to go back to original transaction  

 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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6. How to Close Records 

In document with workflow, the final approver is responsible for closing the scanned record.  
After the record is closed, users will not be able to modify the documents of attach additional 
files.  

 

Process Steps 

1. Enter FB03 in the Command field to display the scanned financial document record, and 
click the Enter icon 

2. Click the Services for Object icon 

 

 

3. Click the Record Management icon to display the record 
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4. Click the Edit  

5. Click the Record button and select the Record Close item 

 

 

 

6. Click the Yes button to confirm closing of  the record 
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*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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7. How to Search Documents with Document Finder 

Records and documents can searched and review in the system using the Document Finder. The 
Document Finder is a search tool that enable users to search for records and files within a 
specific  document area using the attributes assigned to the record or documents. For this 
reason, it is critical that users fill out attributes at the time of creating the record.   

 

Process Steps 

1. Use transaction code OA_FIND to open the Document Finder. 

2. Select the required document area 

 

 

 

3. Scroll up and down to find the most appropriate attributes to search the document, and 
populate the required values.  For example, the following fields can be populated: 

 Short description 

 Document Type 

 Fund 



 

 
Umoja Training Create HR Mini Master – Fast Entry 32/48 

 

 

Job 
Aid 

 
Upload Attachments in Umoja 

 Business Area 

 Business Partner 

4. Click the Start Search button 

5. All documents that meet search criteria will be displayed.   

6. Double-click the   icon to display the document  

7. Alternatively click on the record to select it and click the Enter icon  

 

 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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8. Document Attachments in SRM System 

In SAP Supplier Relationship Management (SAP SRM), you can manage attachments for: 

 All purchasing documents, at both item and header level 

Note: In the shopping cart, you can only manage attachments at item level. 

 In a work item during the approval process 

 

SAP SRM supports all formats that can be uploaded from a file directory. 

 

8.1 Attach Documents in Shopping Cart 

 

Process Steps 

1. Create the Shopping Cart and click the Details button  
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2. Go to the Note and Attachment tab  

3. Click the Add Attachment button and browse for the document to be attached 

 

 

Note: Visible Indicator check box is used for restricting the document to Internal only. 

 

4. Click the Browse button to select the file from the system 

5.  
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6. Select the file, 

7. click the Open button 

 

  

8. Type the required description in the Description field 

9. Click the OK button 
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10. Click the hyperlink document in the Description field to display the attachment 

 

 

 

11. Click the Open button and review the attachment 

 

 

 

 

8.2 Modify Attached Documents after It Is Attached in Purchasing Documents 

 

Process Steps 

1. Navigate to the Header tab and click the Notes and Attachment tab 

2. Alternatively click directly the Noted and Attachment tab  
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3. Click the Versioning button and select the Check-out item to modify the existing 
attachment 

 

 

 

4. A message appears at the top of the screen indicating that the attachment has been 
check out 
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5. Click the Versioning button to upload the document in its current version 

6. Select the Check-in item.   

7. Select the Check-in New Version item to upload a new version of the document,  

 

8. Click the Browse button to select the file from the system 

9. Click the Check in New Version button 
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10. If a new version of the document is uploaded, the version number will be changed 

 

11. Click the Edit Description button to modify the description of the document 

12. Type the new description in the New Description field 

13. Click the OK button 
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8.3 Upload Documents via Collaboration with cFolders 

 

Process Steps 

1. Click the Create button to create the collaboration link to cFolders 

2. Click the Collaboration link created to launch cFolders launchpad 
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3. Click the Folder to navigate the details of the folder details and create further structure 

 

4. Click the Create button  

5. Click the Folder link to create a new folder as per the requirement 

6. Populate the Name field  

7. Click the Save button 
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8. Select the folder created to upload a document inside the folder.  In this case, select 
Technical Evaluations folder 

9. Populate the Name and Description fields 

10. Select the Upload Local File radio button 

11. Click the Continue button 

 

12. Click the Browse button to select the file from the system 

13. Click the Save button 
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14. Populate the Name field  

15. Click the Save button 

 

 

*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   
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9. Naming Convention and Standards 

 

9.1 Upload Documents via Collaboration with cFolders 

 Supporting documents should be uploaded in PDF Format.  As such, PDF versions of 
word, excel and other types of document should be uploaded 

 Although Excel and Word documents can be uploaded in SAP, these document are 
accessible and can be modified during the process before the record is closed 

 Users will not be entitled to delete any documents in the system.  The system will 
prevent users from performing this activity.  In case of error while uploading 
incorrect documents, a new document will be uploaded only if document was 
“saved”.  The documents will be attached in a specific node of the record model 

 The document will be saved with the proper attributes : 

o Unique ID – Document / Year 

o Short Description – Document / Year 

o Fund – Applicable to FI documents 

o Business Area – Applicable to FI documents 

o Document Type – Applicable to FI documents 

o Business Partner – Applicable for FI / RE documents 

o Person Responsible – Applicable for Real Estate(RE) documents 

o Authorization Group – Applicable for Real Estate(RE) documents 

 When documents are linked to Workflow, final approvers are responsible to lock 

records to prevent further modifications.  This activity will ensure that other users 

are not allowed to attach or modify documents, after the approval process is 

completed 

 Accuracy and consistency in folder and document names is crucial to be able to 

easily retrieve documents later 

 The naming conventions are designed to be as intuitive as possible. Whether created 

originally in electronic or paper form, these documents all need to be named 

appropriately and filed in the correct electronic folders.  In order to facilitate the 

search of document in SAP, the following naming convention must be followed: 

o Naming convention for finance documents: 

 Unique ID – Year-Doc Number-Sequential Dcmt. No. 
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 Short Description – Year-Doc Number-Sequential Dcmt. No. 

o Naming convention for Real Estate Contract Documents: 

 Unique ID – Contract Number 

 Short Description – Contract Number 

 If a document is uploaded by mistake, add the word “DO NOT USE” as part of the 

Short description field 

 

 

9.2 Practices to Avoid in Naming Convention 

Files uploaded to Umoja environment should follow these guidelines: 

 Use the standard naming convention provided in the Umoja Job Aid for the type of 
documents you are uploading 

 Do not use the following characters in the file names: " # % & * : < > ? \ / { | } ~ .. 
(two or more consecutive periods) 

 ATTENTION: keep file names shorter than 75 characters 

 Files have an extension before being uploaded into the system 

 Avoid starting a file name with a period (.)  

 Avoid using two consecutive periods (..) in a file name 

 

9.3 File Name Extensions 

There are certain file types that are rejected because they can be harmful to the system.  The 
list of file extensions that are likely to be forbidden by the environment are as follow:  
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File Extensions Forbidden 

.ade .chm .hlp .ksh .mav .msh1xml .prg .shtml 

.adp .class .hta .lnk .maw .msh2 .printer .soap 

.app .cmd .htr .mad .mda .msh2xml .pst .stm 

.asa .com .htw .maf .mdb .mshxml .reg .url 

.ashx .config .ida .mag .mde .msi .rem .vb 

.asmx .cpl .idc .mam .mdt .msp .scf .vbe 

.asp .crt .idq .maq .mdw .mst .scr .vbs 

.bas .csh .ins .mar .mdz .ops .sct .ws 

.bat .dll .isp .mas .msc .pcd .shb .wsc 

.cdx .exe .its .mat .msh .pif .shs .wsf 

.cer .fxp .jse .mau .msh1 .prf .shtm .wsh 

 

9.4 File Size Recommendation 

In attaching documents into Umoja, please be mindful that due to bandwidth limitations in 
some missions, large files could affect performance.  We recommended the following best 
practices: 

 Limit the size of attached files to the minimum possible, so please consider resizing 
image files before uploaded them 

 Use black and white settings for scanned pdfs files 

 Consider resizing or reducing the number of embedded pictures in documents  

 Use newer file formats for office documents, like docx or xlsx 

 

When scanning or converting documents like receipts or forms a resolution of 200dpi and Black 
and White settings are enough for a correct scanning. 

 

Note: For the current UMOJA/SharePoint integrated environment, we recommend 10 MB as a 
maximum file size.  If the file to be attached exceeds that limit, please try to convert it to pdf, 
using the “Smallest file size” setting if it is available and Black & White as color, or with settings 
of 200dpi and Black & White if the setting is not available (when scanning, for example). 
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*  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *  *   

 
 
 
 

 


